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Chapter 1
Introduction

This manual is part of the Dissolved Oxygen Analyser documentation. It will give the user a
detailed description of the titrator and program operation. For hardware and software
installation and a general introduction to the system, see the tutorial.

Please read the files WHATSNEW.DOC and README.DOC in your DOA directory for up-to-
date information on revisions and corrections to this manual.

Chapter 2
Functional Description

2.1 Photometer

The first version of the SiS titrator has a single-beam photometer with blue light at the
absorption wavelength of iodine. By use of a high resolution analog-to-digital converter the
decreasing of the absorption during the titration is recorded with very high precision. The new
photometer, in addition to the blue beam, has a red one which is little attenuated by the
iodine. This beam is used to estimate the transmission endpoint after titration. The
transparency of the sample in the blue is then nearly identical to the almost unchanged one
in the red. The light sources are solid state devices (light emitting diodes) with low power
consumption. To prevent errors from daylight or illumination effects they are modulated.

2.2 Algorithms

This section will give you some information about the titration process, the endpoint
calculation, and the quality of titrations. To understand the descriptions you need some
mathematical basics about polynomial approximation, linear regression, and differential
calculus.

2.2.1 Titration Process
Every titration will be done in three steps:
1. Fast titration phase

During this phase the system dispenses decreasing amounts of titer until a specific
transmission is reached. Between every step the system will wait some time to ensure
that the dispensed titer has reacted mainly. This wait time is called "Fast Delay" and
can be changed by the user. The default value is two seconds; proper delay times are
between two and five seconds. The fast titration phase ends when the transmission
reaches the estimated endpoint multiplied with the "Fast Factor". The default value is
0.92; proper factors are in the range from 0.85 to 0.95.

For the 1-channel systems the "Fast Factor" does not exist. In this case the fast phase
ends when the entered transmission value is reached or the primary shot volume has
been dispensed.



2. Wait time between fast and slow titration phase

After the fast titration phase, the system has to wait some time to ensure that all the
dispensed titer has reacted. The default value for this "Wait Time" is ten seconds.

3. Slow titration phase

During this phase the system dispenses constant amounts of titer. These amounts are
defined by the "Step Size". Every step corresponds to 1/10000 of the burette volume.
The default value is five; proper step sizes are in the range from two to ten. Like in the
fast titration phase, there is a delay time in the slow phase. The default value for the
"Slow Delay" is also two seconds. The slow titration phase ends, when the
transmission is nearly constant. To get the value of the constant transmission and the
accuracy of the measuring (e.g. noise from air bubbles), the system has to dispense
some more titer.

During the slow titration the measured transmission values are checked for spurious points
from air bubbles or particles in the sample to eliminate these points.
2.2.2 Titration Curves

The graph of transmission as a function of titer volume is based on de Beer's law.
Theoretically the function is:

T=T,", for0< Vi< Vens
T = T max, for Vite. > Vend

with T = transmission,
To = transmission at the start of titration,
Tmax = transmission at the end of titration
c = a constant factor,
Viit = titer volume, and
Veng = titer volume equivalent to dissolved oxygen.
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Figure 2.1 Theoretical Titration Curves

In practical operation the detected curves will differ from the theoretical function.
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Figure 2.2 Practical Titration Curve

This figure shows a typical titration curve with the approximated function, the end line and the
interesting function points.

2.2.3 Titration End Condition

The titration will stop if the slope of the line calculated by linear regression from the last ten
valid transmission values is zero or negative, that is reaching the transmission maximum. The
average of these values is taken as the end transmission (or end line), which is used for the
endpoint calculation. In addition the point of maximal slope, detected during the slow phase, is
stored for later use.



2.2.4 Endpoint Calculation

The endpoint calculation is done by a third order polynomial approximation of the logarithmic
transmission values in the range from the beginning of the slow titration up to the constant
end transmission. To optimize the polynomial, the approximation is done iteratively,
eliminating the values outside three sigma for every iteration pass. Then the inflection point of
the polynomial is calculated by double derivation. The endpoint is the point of intersection
from the transmission end line and the line which is determined by the inflection point and the
slope of the polynomial at that inflection point (Remember that we are using logarithmic
transmission values; therefore, it is an e-function in reality).

This method guarantees that all valid measuring points are used for the endpoint calculation
instead of a subset. If the approximation fails (e.g. no inflection point inside the valid range,
the inflection point is a saddle point, or there are not enough measuring values during the
slow titration), the endpoint will still be calculated by intersection point determination, but by
using the point of maximal slope, detected during slow titration, by linear regression. In these
cases you will get a warning message. To assess the quality of the endpoint calculation,
observe the titration curve obtained by the Graph command. Particularly when the inflection
point is a saddle point, the titration may have a very high accuracy when the approximated
function is nearly a straight line (This occurs sometimes in the demonstration program, but not
very often in real titrations).

2.2.5 Accuracy of Endpoint Determination

The accuracy is calculated from the variation of the end line and the approximated polynomial
(or the data calculated during titration, if the approximation fails). By using small titer amounts
during slow titration (1/2000 of burette volume) and optimization of the curves, the calculated
errors are often very small (0.05 . . . 0.001% relative to burette volume). Therefore, the
accuracy of the system generally is based on the error of the motor burette (absolute error <
0.3 %, reproducibility error < 0.1 %).

2.3 Titration Procedures

The next part will give you some brief information to the preparation of samples and titration
procedures. The software supports the WOCE and ISO standards for whole bottle titrations.
All additional features mentioned in the WOCE standard but not in the ISO standard are also
available in ISO mode. For more information, see the WOCE manual (1991) or Carpenter
(1965) and the ISO specifications.

2.3.1 Standardization

WOCE: Standards should be determined in pure water, according to the WOCE
recommendations. It is the procedure described by Carpenter (1965) with the
extension of adding manganous chloride to the standards.

To make a standardization, pipette your standard solution (10 ml of 0.01 N
potassium iodate (KIO3)) into a bottle, nearly fill with distilled water, add the
same volumes of reagents as for titrations (sulphuric acid (H2SO4), sodium
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ISO:

iodide-sodium hydroxide (Nal/NaOH) and manganous chloride (MnCl,)), and
start the standard determination.

Dissolve approximately 0.5 g potassium iodide or sodium iodide (Kl or Nal) in
100 to 150 ml pure water and add 5 ml sulphuric acid (H2SO4). Mix the solution
and add exactly 20 ml standard solution (KIO3, 10 mmol/l). Then fill up to 200
ml with pure water and start the standard determination.

2.3.2 Blank Determination

WOCE:

ISO:

Blanks should be determined in pure water, according to the WOCE
recommendations and Carpenter (1965). To determine the blank value pipette
1 ml of your standard solution into a bottle, nearly fill with pure water, add the
same amount of reagents as for titrations, and start the first blank titration. Then
add another ml of standard solution into the solution and titrate the liberated
iodine. If you want to get a more precise result, repeat the last step one or more
times. The blank value is calculated by subtraction of the average of all
additional titer volumes from the first one.

Blank determinations are not mentioned in the ISO standard, but the software
allows blank determinations even in ISO mode. They are handled in the same
way as for the WOCE standard.

2.3.3 Sample Titration

WOCE:

ISO:

Fill and overflow the flask with at least three bottle volumes, add the reagents
(MnCl; and NaOH/Nal; e.g. 1 ml of each) and stopper the flask. Shake the
bottle and allow the precipitate to settle. After settling, add the sulphuric acid,
place a magnetic stirring bar in the flask, place the bottle in the photometer and
start the titration. Take care to avoid the introduction of air bubbles.

The software supports only whole bottle titrations. Fill the flask, add the
reagents (1 ml MnCl, and 2 ml NaOH/Nal) and stopper the flask. Shake the
bottle and allow the precipitate to settle. Before titration, add 1.5 ml sulphuric
acid.

2.3.4 Duplicate Samples

WOCE:

ISO:

The WOCE recommendations insist on the titration of duplicate samples to
provide a reliable estimate of analytical precision. They should be taken for at
least 10% of all samples from a data set. To make a duplicate sample, prepare
two flasks from one sample, enable the duplicate sample switch in the titration
menu (duplicate samples must be enabled in the configuration menu), and start
the titration. The reproducibility, calculated from all duplicates in a data set, is
stored in the data file together with other statistics.

Procedures for duplicate samples are not described, but mentioned in the ISO
standard. The software handles duplicates in ISO mode in the same way as in
WOCE mode.



2.3.5 Titer Concentration

The concentration of the thiosulphate titer should be strong enough, to titrate nearly all
samples with a titer volume less than one burette volume. If the titer is not strong enough, the
burette has to be refilled during titration, producing less accurate results. Especially for
standardization the titer volume must be less than one burette volume, because an inexact
result will affect all following titration results. On the other hand the titer should not be too
concentrated, as this will lead to less accurate results and could, in the worst case, cause
failure of the titration.

2.4 Calculations
This chapter lists all equations, used by the program to calculate oxygen concentrations. All

calculations will match the WOCE (World Ocean Circulation Experiment) and the ISO
(International Standardization Organization) recommendations.

Titer concentration in mmol/l (ISO, 1983):

The original ISO equation is:

_6%20*1.6
Vstd

c

for 20 ml of 10 mmol/l iodate standard.
The used equation is:

o= V103 UN 103
Vstd

Vag = thiosulphate titer of standard (ml)

Vios = volume of iodate standard (ml)
Nios = normality of iodate standard (mmol/l)

Oxygen mass concentrations in mg/l (ISO, 1983):

The original ISO equation for whole bottle titrations is:

MV,
4*Vbot

0;



with

M:
Vi
C
Vbot
Vreg

f[ — V/)Ot
Vbol - Vreg

= relative molar mass of oxygen (32)

= thiosulphate titer of sample (ml)

titer concentration (mmol/l)

volume of sample bottle (ml)

= volume of sample displaced by reagents (ml)

The used equation is:

Vx

M 8
x” w. *C* ~)- re *]000*7
0, (V<= V biaw) 4 )-(DOeg 5.598)

Vbot - Vreg

= thiosulphate titer of sample (ml)

Vukaw = thiosulphate titer of pure water blank (ml)

Vbot
Vreg

= volume of sample bottle at the pickling temperature (ml)
= volume of sample displaced by reagents (ml)

DOy = absolute amount of oxygen added with reagents (ml)

To match the original equation use the default values:

Voikaw =0 ml
DOrg =0 ml

Oxygen volume concentrations in ml/l (WOCE, 1991):

Vx

(V =V iikaw) ¥V 103 * N1os * 3598
(V sia -V bika)
(Vbot - Vreg)

_1 000 * DOreg

0;=

= thiosulphate titer of sample (ml)

Vukaw = thiosulphate titer of pure water blank (ml)

Vstd
Vbot
Vreg
Vios
Nios

= thiosulphate titer of standard (ml)

= volume of sample bottle at the pickling temperature (ml)

= volume of sample displaced by reagents (ml)

= volume of iodate standard at temperature of standardization (ml)
= normality of iodate standard at temperature of standardization

DOy = absolute amount of oxygen added with reagents (ml)

Oxygen weight concentrations in uM/kgsw (WOCE, 1991):




_ 44.660* 0(ml/ 1)

O(uM/kg,,)
pSW
44.660 = 1000/molar volume of oxygen gas at STP (Weiss, 1981)
Oo(mif) = O, volume concentration (ml/l)
Psw = density of seawater at the sample temperature (g/cm?®)
Percentage O, saturation (Weiss, 1970):
~ 100(%)* O,(ml/1)
2sat ~ ec
C =-173.4292 + 249.6339 * (100 / T) + 143.3483 * In(T / 100) -

21.8492 * (T /100) +

S * (-0.033096 + 0.014259 * (T / 100) - 0.0017 * T/ 10000)
T = sample temperature (Kelvin)
S = salinity (psu)

Density of pure water in g/cm® (Bigg, 1967):

0, =0999842594 +6.,79395200°07= 9.095290110T7 T#
10016850007+ 112008811070 & 6536382 1000° T°

T = temperature (°C); range 0 - 40 °C

Density of seawater in g/cm’ (Millero and Poisson, 1981):

p., = p, + A0S+ BOS"™+ @ S?

Pw = density of pure water (g/cm?®)

S = salinity (psu); range 0.5 - 43 psu

T = temperature (°C); range 0 - 40 °C

A = 8.24493*10 - 4.0899*10° * T + 7.6438*10% * T2 -
8.2467*107° * T3 + 5.3875*1072 * T*

B =-5.72466*10° + 1.0227*107 * T - 1.6546*10° * T2

C = 4.8314*10"

Volume corrections (WOCE, 1991) for bottles and pipettes:

V= V<20) L1+ al(T= 20))

V(zo) = volume at 20 °C
a = cubical coefficient of thermal expansion (1/°C)
T = actual temperature (°C)



Standard normality correction (WOCE, 1991):

P
N103 = N103(20) Di
pw(ZO)
Nio3(20) = normality of iodate standard at 20 °C

pwr = density of pure water at temperature T (g/cm?®)
Pwo) = density of pure water at 20 °C (g/cm®)
T = temperature (°C)

Titer volume correction:

Dp aw(Tstd)
V.= Vx( Ttit)

X
pdw(Ttit)
Vyity = titer volume at current temperature T

Pw(Tsta) = density of pure water at standardization temperature Ty (g/cm®)
pwrity = density of pure water at current temperature Ti; (g/cm®)
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Chapter 3
The DO Analyser Software

3.1 Convert Bottle File

The software includes a file named CONVBOT.EXE. It is used to convert bottle files created
with older software versions to the 3.x format. To convert old bottle files select the drive and
directory containing the old file and type "CONVBOT <Enter>". The program will create a
version 3.x binary file (DOA.BOT) from the old text files (BOTTLE.TXT or FLASCHEN.TXT),
without deleting them.

3.2 Calibration Program

The software package includes a calibration program DOACAL.EXE for the 2-channel
system. For a detailed description of the calibration procedure see the Technical Reference
Manual. Note that the system is calibrated by the factory and that a new calibration should
only be done by qualified technical personnel if it is really necessary.

3.3 Hercules Graphic Utility

To use the Graph command with Hercules graphic cards, you must install the terminate-and-
stay-resident program MSHERC.COM before starting the DOA program.

3.4 Command Line Syntax

Usage: DOA [AMCL}] [KEDY}] [/X] [/Zname] [/Fname] [[{H?}]
DOADEMO [{MCL}] [ED}] [/X] [/Zname] [/[Fname] [/1] [{H?}]

Command line parameters:

Monochrome display mode (default is auto detection)
Colour display mode (default is auto detection)

LCD display mode (not yet implemented; use colour table)
English language (default setting)

German language

Write all titration data to log file (default is off)

Z<name> Set log file name to 'name' (default name is DOA.LOG)
F<name> Use configuration file 'name' (default is DOA.CFG)

xXOomro=Z2

1 Demo for one channel system (only for DOADEMO.EXE; default is two
channels)
H,? Display help screen with command line parameters

The options are selected by typing a switching character (/' [slash] or -' [minus]) followed by
the option character (upper-case or lower-case). Each option must be separated from another
by a white-space character (e.g. space or tab).

All options will overwrite the current settings (from the configuration file DOA.CFG or the
default settings if no configuration file is found). The options 'M', 'C', 'L", 'E' and 'D' are saved in
the configuration file. Thus the settings will be valid until they are overwritten by other settings.
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The options X', 'Z' and '"1' (for DOADEMO.EXE) are only valid for the current program
execution. The default settings (no configuration file found) are English language and
auto-detection for the display mode (monochrome or colour, depending on video card).

If you select the X-option the titration steps (transmission values and dispensed titer) of every
titration will be written to an ASCII log file. This may be of interest to you, if you want to create
your own graph of the titration curve. Even if the X-option is not specified you can save the
data after each titration with the Log command.

The F-option is useful if you have more than one exchange unit with different titer
concentrations. So the program must only be restarted when changing the unit instead of
starting new standard and blank determinations. The distribution disk includes an example
batch file for the use of different configuration files.

3.5 Demo Program

The demo program DOADEMO.EXE works like the program DOA.EXE. However, the results
of titrations, standardizations and blank determinations may sometimes be rather improbable
because they are produced by a random number generator. In particular, the curves will fit the
theoretical curves of light absorptions. In addition to the full version you can select a
demonstration mode for the old 1-channel hardware by the command line option '/1".

3.6 File Formats

All files created by the software are stored in binary format, so you cannot read them with an
editor or word processor. To produce readable text files use the Print to File option in the Print
Menu. The Print Menu is available at many points inside the menu system. Text files contain
only ASCII characters including the IBM PC graphics and national characters (codes 128 -
255). All system and data files contain an identification string, to ensure that only valid files will
be used. The system uses four types of data files with identical file format, but with differences
in the mode (WOCE or ISO) and replication data (duplicates enabled or disabled). The
standard extension for data files is "DAT", but other extensions may be used.

Besides the data files, the software uses some system files with reserved names:

- DOA.CFG: The configuration file, holding all configuration data, the data of the last
titration, standardization and blank determination, the file name of the
last used data file etc.

At the start, the program first tries to load this file from the drive and path
of the program, and if this fails to load the configuration file from the
current drive and directory. If no configuration file is found, the program
will ask if the file should be created with the default data.

- DOA.BOT: The bottle file, holding all bottle data. If the configuration file exists, this
file is loaded from or created in the drive and path of the configuration
file, otherwise the current drive and directory will be used.

- DOA_*.HLP: The help text files. The program tries first to locate these files in the
program path. If this fails, the program searches for the files in the
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current directory. Note that no error or warning message is produced, if
no file is found.

- DOA_*.NDX: The help index files.
- DOA_*.MSG: The message text files.
- DOA_*.STM: The status message files.

Please do not modify the data or system files, because this could produce unpredictable
results.
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Chapter 4

The Menu System

4.1 Help System

To call up Help, press <F1>. The Help window details the functions of the item on which
you're currently positioned. To get to the Help Index press <F1> again once you're in the Help
system. Inside the index list you can choose your desired help index to get the attached help
text. For more information about the help system see section 4.3.30, Help Menu.

4.2 Status Line

The Status Line at the bottom of the screen contains some short information about the current
item you're on.

4.3 Menu Commands

For use of the keyboard and the mouse inside the menu system, see the tutorial.

File ‘ ‘ Bottle ‘ ‘ Titration ‘ ‘ Standard ‘ ‘ Blank ‘ ‘ Craph ‘ ‘ Options ‘ ‘ Help
I I I I
View Titration | Configuration Help on Help
Text Log File Parameters Index
Shell External =
Quit Trans Test
Hard Test
Dosimat Func
Sekect e | [ A Stort Determ Determ Select Fil eadme e
. ‘ Log File
Delete Print Print
Print
Add /Edit Doto Set %
View Al 0K 0K 0K Grid Config
Single  Print  Deviation Graph Next Next Lin/Log
‘ ‘ Log Graph Graph Print
‘ orint ‘ ‘ Print ‘ Print Log Log Data Field
Zoomin
ZoomQut

Figure 4.1 Menu Tree
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4.3.1 Main Menu

ile ottle itration Blank alue tandard raph ptions elp 12:88:81

Info on Dissolved Oxygen Analyser software
Figure 4.2 Main Menu

At the top of the main screen is the main menu bar, offering nine selections and displaying the
current time at the right:

= (About)  Displays the product version information.

File Handles files, invokes DOS and quitting the program.
Bottle Handles bottles (viewing, adding, deleting, printing).
Titration Determination of the dissolved oxygen from a sample.

BlankValue Blank Value (view or print current value, determination of blank value).
Standard Standardization (view or print current data, determination of new data).

Graph Display the graph of the last titration.
Options Allows you to configure your system and lets you check the hardware.
Help Invoke the help system (Help On Help, Help Index)
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4.3.2 File Menu

PN ottle itration Blank alue tandard raph ptions elp 12:08:05

ext File

5 Shell
nit

Uiew or print data file
Figure 4.3 File Menu

The File pull-down menu allows you to view and print existing data files, view and edit text
files, temporarily go to the DOS shell, or exit the program.

View Data  Allows you to view and print existing data files. After activation of View Data the
File Select window will pop up, prompting for input of a file name.

Text File Lets you load an ASCII file vor viewing and editing. This command is only
available if an external editor is installed with the External item in the Options
menu.

OS Shell Leaves the program temporarily and takes you to the DOS prompt. To return to

the program, type "EXIT <Enter>". This is useful when you want to run a DOS
command without quitting the program.

Quit Quits the program and returns you to the DOS prompt. There is no verifying to

exit from the program, because all important data are saved automatically
before the program terminates.
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4.3.3 File Selection

[FPTEN ottle itration Blank alue tandard raph ptions elp 12:88:28
“Uicw Data M File Select
ext File
————| ame
3 Shell . .5+ DAT
nit
————— iles
I
LN
DoA.DAT
I50_D.DAT
I530_5.DAT
WOCE_D.DAT
WOCE_S5.DAT

E:~\DOA311NDEMON=.DAT
Y DIR 21.84.95 15:89

Select file or directory
Figure 4.4 File Selection

From this window you can select a file for viewing, printing or data output.

Name The name of your data file, a directory specification, or a search mask.

Files Select an existing data file to load, or a directory to change to from this list by

using the cursor keys or the mouse (activation with double click). When you
move through the list, the name of the current file or directory is copied to the

Name field.

Drives Select a new drive.

Open Opens the file from the Name Field or changes to the directory specified in the
Name Field.

Cancel Leaves the File Selection Window without changing the current file name.

Help Displays the help screen about the File Selection Window.

The file list contains only directories and files of the currently required types. At the bottom of
the window the current drive, path and search mask and the file size, date and time of the
currently selected file or directory are displayed.
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4.3.4 Data Overview

ottle itration Blank alue tandard raph ptions elp 1Z2:688:48
L 1 Data Ouerview E:WOCE D.DAT [WOCE]

Date Time Station Depth Bo# BotUol BUolZB Botx Tz=w Tpick
13:27 35i3 B 64 59.53 59.54 1. .18
13:31 5i3 B 65 59.49 59.58 1. .28
13:34 5i3 g 77 59.56 59.56 1. .45
13:37 5i3 A 79 53.99 58.99 1. .35
13:41 5iS3 A 88 59.92 59.92 1. .38
13:44 5i3 B8 93 59.83 59.89 1. .18
13:47 35i3 B8 93 59.79 59.79 1. .38
13:58 35i3 B8 99 59.71 59.71 1. .48
13:53 Si3 B 63 59.78 59.71 1. .9a
13:55 S5i3 B8 64 59.54 59.54 1. .25
13:59 5i3 B+ 65 59.58 59.58 1. .18
13:59 5is B= 7?7 59.56 59.56 1. .18
14:86 S5i3 A 79 53.99 58.99 1. .48
14:18 5i3 A 88 59.92 59.92 1 80

I rint l eviation I

Display selected =single data set
Figure 4.5 Data Overview

This window gives you a total overview on all data sets in the selected data file. On the top
border of the window the name of the data file, together with the drive where it is stored and
the determination method are displayed. Note that an asterisk behind the depth field marks
the data sets as parts of duplicate samples.

Move through the data file by using the mouse and the scroll bar or by using the following
keys:

<Up>: Previous data set
<Down>: Next data set

<Left>: Column left

<Right>: Column right

<Home>: First data field of data set
<End>: Last data field of data set

<PgUp>: Previous page
<PgDn>: Next page

<Ctrl-Left>: Data field left
<Ctrl-Right>: Data field right
<Ctrl-Home>: First data set on screen
<Ctrl-End>: Last data set on screen
<Ctrl-PgUp>: First data set in file
<Ctrl-PgDn>: Last data set in file

Single Opens the Single Data Set Window, displays the currently selected data set in a
wide format, and lets you print the single data set to the line printer or a text file.

Print Prints all data sets from the data file to the line printer or a text file. If you only
have a standard printer, the width of one data set line will exceed the printing
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width of your printer. To get a readable output you can select the Split Printing
option in the Configuration window (see Options Menu).

Deviation Displays statistics (precision, reproducibility) about the titration data from the
current data file. This option is only available if the data file contains duplicate
samples (see Duplicate Sample Control in the Options Menu / Configuration
Window).

Cancel Leaves the Data Overview Window and returns you to the Files Menu.

4.3.5 View Single Data Set

ottle itration Blank alue tandard raph ptions elp 12:88:47
L 1 Data Overview E:WOCE_D.DAT L[WOCE]
L 1 Single Data Set
Date : B1.82.1993 Bottle numher 3 63
Time : 13:24 Bottle volume : 59.787 ml
Station i 5i3 Bottle volume (ZA°C) ; 59.718 ml
Depth : B m Cubical expansion coeff: 1.8E-5 1-°C
Salinity 3 B.8808 psu Sample temperature Tsw : 14.388 °C
Blank volume : —B.8816 ml Pickling temperature Tp: 14.788 °C
Standard volume : B.7223 ml Titer temperature Ttit : 19.188 °C
Iodate volume : 18.88688 ml Accuracy of endpoint ; a.811 =
Iodate normality: B.81688 Titer volume : B.3678 ml
02 concentration 3 4.9288 ml-1
Reagent volume : Z.8888 ml 0Z concentration ; ?.832Z mg-1l
Abs. reag. 02 3 8.8817 ml 02 concentration : 219.936 pHskg
Method ! WOCE 02 concentration 3 68.76Z2 =
Comment : Demo measurement
3 ancel B
— E— — E—

Print this single data set
Figure 4.6 View Single Data Set

Displays a single data set in a wide, screen filling format.

Print Prints the single data set to line printer or text file.
Cancel Leaves the Single Data Set Window and returns you to the Data Overview
Window.

19



4.3.6 View Replication And Precision

ottle itration Blank alue tandard raph ptions elp 12:88:57
-C ] Data Overview E:WOCE_D.DAT [WOCE]
Date Time Statif[L 1——Replication and Precision ck T{
13:24 3iS
13:27 3i3 Number of replicates g 3
13:31 3is Numbher of single samples : 32
13:34 3iS Replication ratio : a8 #
13:37 3i3 Max 0Z concentration 8.988 ml-1
13:41 3iS Standard deviation o 8.817 ml-1
13:44 35iS Reproducibility B.37 =
13:47 3iS
13:58 3iS
13:53 315 ancel
13:55 5is d d
13:59 3iS
13:59 315
14:86 3135 B V9 583.99 58.99 1.8BE-5 13.Z8 13.48 19
14:18 3iS A 88 59.92 59.92 1.8E-5 23.98 Z3.88 19
" :
ingle B rint B eviation B ancel B

Print deviation data

Figure 4.7 View Replication and Precision

Displays statistics about the titration data from the selected data file.

Description of the statistic data:

Number of replicates:

Number of single samples:

Replication ratio:

Max O2 concentration:

Standard deviation:

Reproducibility:

The total number of duplicate samples in the data file.

The total number of single samples in the data file.

The percentage ratio of the number of duplicates to the sum of
the number of duplicates and the number of single samples.

The maximal measured O, concentration from this data file.
Standard deviation of differences from all duplicate samples.
Percentage reproducibility (20) of all duplicates relative to the
maximal O, concentration.

Print Prints the statistics to line printer or text file.
Cancel Leaves the Replication And Precision Window and returns you to the Data
Overview Window.
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4.3.7 Print Menu

ottle itration Blank alue tandard raph ptions elp 12:89:17
L 1 Data Ouverview E:WOCE _D.DAT [WOCE]
Date Time Statipl 1—Replication and Preciszion ck T%
B1.82.93 13:24 3iS
B81.82.93 13:27 Si3 Number of replicates 5 3
81.82.93 13:31 Si3 Numbher of single samples : 32
81.82.93 13:34 Si3 Replication ratio : 8 P
A1.82 .93 13:37 Si3 Max 02 concentration 3 8.988 ml-1
A1.82 .93 13:41 Si3 Standard deviation o B.884 ml-/1
B1.82.93 13:44 3iS Reproducibility B.88
B1.82.93 13:47 3iS
B1.82.93 13:58 3iS
B1.82.93 13:53 3i3 rint g ancel g
81.82.93.C 1 Print Menu
B1.82.93
B81.82.93| Text file ,ame:
ext file I rinter I ancel I

Enter text file name (or device PREN, AUX, LPTn, COMn), FZ=File select hox

Figure 4.8 Print Menu

The Print Menu can be activated by many program items to print the currently selected and/or
displayed data to your line printer or to a text file.

Text File Name

Text File

Printer

Cancel

The name and optional drive and/or path of the file, to which the output
should be written. If the output file exists already, you will get a warning
message, giving you the choice of overwriting the existing file, appending
the data to the file or leaving the Print Menu. Note that also the DOS
device names PRN, AUX, LPTn and COMn are valid names and that the
output will be directed to the specified DOS device instead of a file. By
pressing the function key <F2> you may open the File Select window to
choose an existing file or to change the drive or directory.

Prints the data to the file or device specified in the Text File Name field.
The output will be done without any control characters except the
carriage return and line feed sequences.

Prints the data to the selected parallel printer. For parallel printer
selection, open the Configuration Window in the Options Menu.

Leaves the Print Menu and returns you to the previous menu or window.
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4.3.8 Bottle Management

ile iaiaa st itration Blank alue tandard raph ptions elp 12:89:29
Bottle Management
iew
dd B
No VUolumelml] m[l/“C]l
1 146.538 1.8E-5 gy
Z 145.794 1.8E-5 n elete
3 146.427 1.8E-5 & el
24 28.818 1.8E-5
63 59.718 1.8E-5
64 59.548 1.8E-5
65 59.568 1.8E-5 rint
76 59.438 1.8E-5 el
7 59.5648 1.8E-5
79 58.998 1.8E-5 ave
80 59.9Z8 1.8E-5 el
93 59.898 1.8E-5
94 59.558 1.8E-5 |} 1 B
: ance

Bottle overview

Figure 4.9 Bottle Management

The Bottles Window contains the data management for your bottles.

View

Add

Delete

Print

Save

Cancel

A sorted list of all bottles. You can move through the list using the <Up>,
<Down>, <PgUp> and <PgDn> key, or by using the scroll bar with the mouse.

To add a new bottle to the list or change the data of an existing bottle.
Removes the currently selected bottle from the list.

Prints the complete list of bottles to line printer or text file.

Leaves the Bottles Window and saves all data on disk.

Leaves the Bottles Window without saving data.
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4.3.9 Add Bottle

ilelliI77EN itration Blank alue tandard raph ptions elp 12:89:36
Bottle Management
iew
dd 3
No Volumelml] m[i/"C]l
1 146.538 1.8E-5r[ 1—HNew Bottle
Z 145.794 1.8E-5
3 146.427 1.8E-5| Humbher : 1N
24 26.0810 1.8E-5
63 59.718 1.8E-5| Volume [mll : 146.538
b4 59.5408 1.8E-5
b5 59.5608 1.8E-5| « [1Be-5-"C1: 1.8
76 59.4308 1.8E-5
s 59.5608 1.8E-5 K
79 56.9908 1.8E-5 —
aa 59.928 1.8E-5
93  59.998 1.8E-5 i
94 59.5508 1.8E-5

Enter hottle number [Range: 1 — 9991
Figure 4.10 Add Bottle

Enter the data of a new bottle or change the data of an existing bottle. When this window
pops up, all data will be preset to the values from the current list position in the Bottle
management window.

Number The number of your bottle. The program will handle up to 999 different bottles
with numbers from 1 to 999.

Volume The volume of your bottle in ml at the reference temperature of 20 °C. Valid
volumes are in the range from 8 to 600 ml.

a The cubical coefficient of thermal expansion for the glass of your bottle. The
coefficient is used to calculate the bottle volume for temperatures different from
the reference temperature of 20 °C. Typical values for glass wares are
1*10"°/°C for borosilicate glass and 2.5*10™/°C for soft glass. Valid coefficients
are in the range from 0 to 9.9*10°/°C.

OK Adds the bottle to the list. If a bottle with the specified number exists already,
you will get a warning message.

Cancel Leaves this window without adding the bottle to the list.
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4.3.10 Titration

ile ottle§EFTEFMBlank alue tandard raph ptions elp 1Z:89:55
L 1 Titration
Date : 38.86.1995
Time 12:89
Station station
Depth - B m
Bottle number : 99
Sample Temperature Tsw : ZB.@EA °cC
Pickling Temperature Tp : ZB.@ea °C
Titer Temperature Ttit : ZB.@ea °C
Salinity ; B.888 psu
Reagent volume : Z2.8008 ml
Abs. oxygen from reagent=s : B.B0HH ml
Comment : comment
Protocol : HNo
Duplicate Sample : HNo
Filename :

tart I ancel l

Enter data file name (Use wildcards or FZ2 to get list of current data files)

Figure 4.11 Titration

Use this window to measure the dissolved oxygen in a sample.

Date

Time

Station

Depth

Bottle Number

Sample Temp. Tsw

The date of the titration. The Date is an optional part of a data
set. By default this field will hold the current date. To enter a new
date, use the format dd.mm.yy or dd.mm.yyyy.

The time of the titration. The Time is an optional part of a data
set. By default this field will hold the time when opening the
Titration Window. To enter a new time, use the format hh:mm.

The Station name is an optional part of a titration data set. Before
starting a titration you can enter the name (max. 15 characters) of
your station. By default this field holds the station name from the
last titration.

The Depth is an optional part of a data set. Before starting a
titration you can enter the depth of your sampling (max. 5 digits).
By default this field holds the depth from the last titration.

The number of your sampling bottle. Before you can start any
titration you have to enter a valid bottle number. For new bottle
numbers see the Add Bottle Window in the Bottles Window. If a
bottle with the specified number is not part of the bottle list, you
cannot leave this entry filed (except by closing the Titration
window) and an error message is displayed.

The temperature of your sample at the time of sampling. This
temperature is used to convert volumetric oxygen concentrations
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Pickling Temp. Tpick

Titer Temp. Ttit

Salinity

Reagent Volume

Abs. Reag. Oxygen

Comment

Protocol

Duplicate Sample

File Name

Start

Cancel

(ml/l) into weight concentrations (UM/kg) and O, saturation. Valid
inputs are in the range from -2 to 40 °C (Note that the calculations
are only defined for temperatures from 0 to 40 °C).

The temperature of your sample at the time of pickling (filling your
bottle). The Pickling Temperature is used to calculate the real
bottle volume at the time of filling. Valid inputs are in the range
from -2 to 40 °C.

The temperature of your thiosulphate titer at the time of titration
(probably now). The Titer Temperature is used to correct the titer
volume relative to the titer temperature at standardization. Valid
inputs are in the range from 0 to 40 °C.

The salinity of your sample, if known. The salinity is used to
convert volumetric oxygen concentrations into weight
concentrations and O, saturation. Valid inputs are in the range
from 0 to 43 psu.

The volume of your sample in ml displaced by the reagents.

The absolute amount of oxygen in ml added with the reagents. By
default this field will hold the value from the last titration. The
presetting value is 0.0017 ml for WOCE mode (Murray et al.,
1968, valid for reagent volumes of each 1 ml) and 0 ml for ISO
mode.

The Comment is an optional part of a data set. By default this
field will hold the comment from the last titration. To enter a new
comment just type in any printable character up to a maximal
string length of 18 characters.

Use the space bar to toggle this option on or off. When Protocol
printing is enabled, titration results will be printed in a short form
to your line printer after each titration. Be sure that your printer is
ready before starting the titration.

Use the space bar to toggle this option on or off. When Duplicate
Control is enabled (see the Configuration Window in the Options
Menu) you can specify that this titration will be a duplicate one.
This option is not available if Duplicate Control is disabled.

The name (and optional drive or path) of the file to which the
titration results will be written. To get a list of existing data files
press the function key <F2> to open the File Select Window.
Before you can start a titration you must enter a valid file name.

Starts the titration of your sample. Be sure that all inputs are
correct and your sample bottle is placed in the photometer.

Leaves the Titration Window and takes you back to the Main
Menu.
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4.3.11 Input Maximal Transmission

ile ottle Blank alue tandard raph ptions elp 12:15:29
-C 1 Titration

Date 38.0686.1995

Time 12:15

Station station

Depth a m

Bottle numher 99

srC 1 Input Max Transmission

P

T] Blue transmizszion 8.7 »

3| Red transmis=sion 66.3

R| Estimated endpoint z

A

C

P K elp ancel

D e e e 8.8 pl

F 8.7 =

B.8 =

Time : 8.8 s
Status:

Enter new (lower) estimated endpoint for turbid samples
Figure 4.12 Input Maximal Transmission
This window exists only if you are working with a 2-channel photometer.
Blue Transmission This value cannot be changed; it is the current percentage
transmission of the blue beam.
Red Transmission This value cannot be changed; it is the current percentage
transmission of the red beam. The Estimated Endpoint entry field
below will hold a value calculated from the red transmission and a
correction factor.
Estimated Endpoint The estimation of the percentage transmission value of your
sample after titration. If your sample is turbid, this value may be
too high. So you can change the value to avoid an over titration.
Note that decreasing the estimated endpoint results in increasing
titration times. Normally the Estimated Endpoint is calculated from
the red transmission, a correction factor, and a general offset.
Turbid samples, especially samples with photosynthetic micro-
organisms, will have a higher blue than red light absorption.
Therefore, it is better to decrease the presetting in such a case.

OK Starts the titration using the above specified estimated endpoint.
Help Displays the help text about the endpoint estimation.
Cancel Aborts the starting of titration and returns you to the Titration

Window.
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4.3.12 Titration Running

ile

Titration running:; Press

12:15:48

ottleFEITTITTMBlank alue tandard raph ptions elp
L 1 Titration
Date : 38.86.1995
Time 12:15
Station station
Depth A m
Bottle numher 99
Sample Temperature Tszuw Z8.8688 °C
Pickling Temperature Tp Z8.888 °C
Titer Temperature Ttit ZB.Bea *C
Salinity H.888 p=su
Reagent volume Z.8088 ml
fAibs. oxygen from reagents 8.8817 ml
Comment comment
Protocol Ho Titration
Duplicate Sample Ho Titer:
Filename DOA. || Transmission:
Ezt. endpoint:
tart Time:
] Status:

144 .6
11.7 =
66.2 ¥

3.8 s
Read

Figure 4.13 Titration Running

to break

During titration the current titration values (titer amount, percentage transmission, estimated
endpoint and titration time) are displayed continuously in the Titration Running Window. If you
want to interrupt the titration, just press <Esc> and confirm the User Break Message with OK.
Note that you can go on with the titration by selecting Cancel, but if you are already in the
slow titration phase the results may be inexact for longer (more than two seconds) delay

times.
The displayed

Titer:
Transmission:
Est. Endpoint:
Time:

Status:

values are:

Total amount of dispensed titer.
Percentage transmission of the blue beam.

Estimated percentage transmission after end of titration.

Total time in seconds since starting the titration.

Current titration step.

The status line can contain the following titration steps:

Dispense:
Read:
Wait:

Titer is dispensed into sample.
System reads transmission from photometer.
Delay cycle to ensure the chemical reaction of the titer.
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4.3.13 Titration Finished

ile ottle Blank alue tandard raph ptions elp 11:41:35

L Titration 1
Date -C ] Titration Finished
Time
Stationm Accuracy : 8.08886
Depth Titer volume : 8.2848 ml
Bottle n 02 concentration 3 3.6249 ml-1
Sample T 02 concentration 5 5.1882 mg-1
Pickling 02 concentration : 162.177 pPM-/kyg
Titer Te 02 concentration 3 57.871 =
Salinity Titration time 1 124.8 s
Reagent
fAbs. oxy raph og rint
Comment — — — ——
Protocol

Duplicate
Filename

DoA.DAT

ancel I

Save result and return

Figure 4.14 Titration Finished
This window will pop-up after a successful titration to display the titration results.

OK Leaves the Titration Finished Window, saves the results in the specified data
file and returns you to the Titration Window. If you had selected a duplicate
sample and the first titration was just finished, the results will not yet be saved
and you will not return to the Titration Window. Instead another window will pop
up, prompting you for the bottle number of the second bottle. After the second
titration, this window will pop up again and the data of the duplicate sample will
be saved after leaving this window.

Graph Displays the graph of the titration curve. For more information see The Graph
Window in the Main Menu.

Log Opens the Log menu to write the titration data (titer-transmission pairs) to an
ASCII file or to print them on a line printer.

Print Prints the complete data of the titration to line printer or text file. The print format
will be the same when printing a single data set from a data file.

The displayed values are:

Accuracy: This value is calculated during the approximation of the titration curve
and gives you information about the accuracy of the endpoint
calculation. It is the percentage standard deviation relative to the
calculated titer volume. If there are many titration steps and little noise
the accuracy may be very good (better than 0.01 %), because of the
optimization algorithm.

Titer volume: The calculated titer volume at the titration endpoint.
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02 concentration: The O, concentration in ml/l, mg/l, uM/kg and the percentage O

saturation.
Titration time: The total time for the titration.
4.3.14 Log Menu
ile ottlel¥TTETITTWBlank alue tandard raph ptions elp 11:41:55
L 1 Titration 1
Date -C ] Titration Finished
Time
Station Accuracy B.8836
Depth Titer volume A.2848 ml
Bottle n 02 concentration 3.6249 ml-1
Sample T 02 concentration : 5.1882 mg-1
Pickling 02 concentration ! 162.177 pPM-kg
Titer Te 02 concentration 5 57.871 =
Salinity Titration time : 24 .8 s
Reagent
Abs. oxy K m raph g og m rint g
L 1 Log Menu

Text file ame:

DOA . LOG
ext file I rinter I ance 1 I

Enter text file name (or device PRN, AaUX, LPTn, COMn), FZ=File =elect box

Figure 4.15 Log Menu

After each titration, regardless of the conditions (oxygen, standard or blank determination),
the Log Menu can be activated to write the pure titration data to an ASCII file or to print them
on a line printer. These titration data consist of a header, the titration data table with titer-
transmission pairs, and the calculated endpoint with intermediate results from the titration
algorithm. The data may be used to plot titration curves or check the titration algorithm. The
Log menu is similar to the Print menu. If you have specified the command line option /X' (see
chapter 3, item 3.4 Command Line Syntax) the titration data will be written automatically to
the log file after each titration.

Text File Name The name and optional drive and/or path of the file, to which the output
should be written. If the output file exists already, you will get a warning
message, giving you the choice of overwriting the existing file, appending
the data to the file or leaving the Log Menu. Note that also the DOS
device names PRN, AUX, LPTn and COMn are valid names and that the
output will be directed to the specified DOS device instead of a file.
output will be directed to the specified DOS device instead of a file. By
pressing the function key <F2> you may open the File Select window to
choose an existing file or to change the drive or directory.
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Text File Logs the data to the file or device specified in the Text File Name field.
The output will be done without any control characters except the
carriage return and line feed sequences.

Printer Prints the data to the selected parallel printer. For parallel printer
selection, open the Configuration Window in the Options Menu.

Cancel Leaves the Print Menu and returns you to the previous menu or window.

4.3.15 Second Bottle Number

ile ottle§EFTEFMBlank alue tandard raph ptions elp 12:17:58
-C 1 Titration
Date ! 38.86.1995
Time 1 12:15
Station ! station
Depth i e m
Bottle number : 99
Sample Temperature Tsw : ZB.@ea °C
Pickling Temperature Tp [ 1-Duplicate Sample
Titer Temperature Ttit
Salinity Bottle number : EEN

Reagent volume
Abhs. oxygen from reagents K ancel
e — ——
Protocol
Duplicate Sample
Filename

DOA.DAT

ancel l

tart I

Enter bottle number of second sample [1 — 9991
Figure 4.16 Second Bottle Number

If you are inside a duplicate sample titration this window will pop up after the first titration,
asking for the bottle number of the second sample.

OK Starts the titration of the second sampile.

Cancel Stops duplicate sample titration. The data of the first titration will be treated as a
normal titration.
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4.3.16 Duplicate Sample Result

ile ottlel¥IITEIMEBlank alue tandard raph ptions elp 12:18:57

-L 1 Titration 1
Date Duplicate Results
Time
Station Number of replicates E s
Depth Number of single =amples : Te
Bottle n Replication ratio 5 8 P
Sample T Max 02 concentration : 218.981 ml-l
Pickling Standard deviation o ; B.224 ml-1
Titer Te Reproducibhility : B.21 =
Salinity
Reagent First sample 6.793 ml-1
Abs . oxy Second sample 6.758 ml-1
Comment fibsolute error B.843 ml-1
Protocol Precision B.63 =
Duplicat
Filename

Save data from duplicate samples
Figure 4.17 Duplicate Sample Result

After successful titrations of duplicate samples this window will pop up to give you some
information about the difference of the two titrations and the reproducibility of all data in your
file. The upper data are the same as displayed in the Replication and Precision window from
the View Data command. Below the dissolved oxygen from both titrations, the absolute
difference between these values (absolute error) and the relative error (precision) are
displayed.

OK Leaves the window, saves the data of the titrations and the statistics, and
returns to the Titration window.

Cancel Leaves the window without saving either the titration data or the statistics.
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4.3.17 Blank Value

ile ottle itrationiJET0AERITEN tandard raph ptions elp 12:19:69

L 1 Blank Value

Last Blank Determination : B1.681.1980 B68:688
Blank Value : B.86880 ml

Determination of new hlank value

Figure 4.18 Blank Value

Displays the results of the last blank determination, lets you print them, and gives you the
choice to start a new blank determination.

Determination Starts a new blank determination.
Print Prints the data of the last blank determination to line printer or text file.
Cancel Leaves the Blankvalue Window and returns you to the Main Menu.
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4.3.17.1 First Blank Determination

ile ottle ‘itration HEGIAESNIES tandard raph ptions elp 12:19:44
L 1 Blank Value
Last Blank Determination : B1.81.1980 #8:88
Blank Value . B.08688 ml
Blank Determination
[¥K1 1. titration : B.8618 ml
Blank Value i B.888H ml
raph i og__ N ancel 1

Start another titration
Figure 4.18.1 First Blank Determination

This window will pop up after the first blank titration.

Next Starts the next blank titration.
Graph Displays the curve of the last titration.
Log Opens the Log menu to write the titration data (titer-transmission pairs) to an

ASCII file or to print them on a line printer.

Cancel Interrupts the blank determination without saving data.
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4.3.17.2 Additional Blank Determination

ile ottle ‘itrationf dENLAGEHNES tandard raph ptions elp 1Z2:20:16
L 1 Blank Value
Last Blank Determination : H1.81.1980 B8 :88
Blank Value : B.80688 ml
Blank Determination
[¥1 1. titration : B.8618 ml
[XK1 Z2. titration : B.86683 ml
Blank Value i B.8816 ml

“ ext 1 raph 1 og g ancel 1

Exit hlank determination and save value

Figure 4.18.2 Additional Blank Determination

This is the window after some additional blank titrations. Note that the window contains
another push button and that the blank value is now calculated from the first and the
additional titrations. After each blank titration, the window contains one line more to display
the results of all titrations. The maximum number of blank titrations is limited to eight.
Therefore, the 'Next' button is not available after the eighth titration.

OK Leaves the blank determination and saves the new blank value.

Next Starts the next blank titration. This button does not exist after the last (eighth)
titration.

Graph Displays the curve of the last titration.

Log Opens the Log menu to write the titration data (titer-transmission pairs) to an

ASCII file or to print them on a line printer.
Cancel Leaves the blank determination without saving the blank value.

2.8 Enable or disable the result of the corresponding titration. Note that the first
value cannot be disabled, because it is necessary to calculate the blank value.
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4.3.18 Standard

ile ottle itration Blank alue| si5iGiyils raph ptions elp 12:21:88
L 1 Standardization
Last standardization : 38.86.1995 1Z2:14
Iodate Volume (Z2B°C) 3 18.80688 ml
Iodate Normality (Z8°C) 3 a.a168a8
Iodate Volume (Tstd) 3 18.80688 ml
Iodate Normality (Tstd) 3 a.818a8
Temperature Tstd 3 20.888 °C
Cubical expansion coeff . : B.8E-5 1-°C
Titer volume : 8.6698 ml

New standardization

Figure 4.19 Standard

Displays the results of the last standardization, lets you print them, and gives you the choice
to start a new standardization.

Determination Opens the Standard Parameter Window to enter the standard
parameters and start a new standardization.

Print Prints the data of the last standardization to line printer or text file.

Cancel Leaves the Standard Window and returns you to the Main Menu.

The displayed values are:

Last standardization:
Volume (20 °C):

Normality (20 °C):

Volume:

Normality:
Temperature:
Cubical exp. coeff.:

Titer volume:
Titer concentration:

Date and time of the last standardization.

Volume of your iodate pipette at the reference temperature of 20
°C.

Normality of your iodate standard at the reference temperature of
20 °C.

Corrected iodate pipette volume at standardization temperature.
Temperature compensated normality of iodate standard.
Temperature of the iodate during standardization.

Cubical coefficient of thermal expansion for the glass ware of
your iodate pipette.

The calculated amount of thiosulphate titer from standardization.
This value is only displayed if you are in the ISO mode.
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4.3.19 Standard Parameters

ile ottle

itration Blank alue raph ptions elp 12:21:88
L 1 Standardization
-C 1 Standard Parameters —
Iodate Volume (Z28°C) : ml
Iodate Normality (28°C) : B.81868
Temperature Tstd : Z0.0868 °C
Cubical expansion coeff. : 8.8E-5 1-°C
tart ancel
e—— —
etermination rint ancel
—— — —

Enter iodate volume at 28 °C [B.5 — 688 ml1l

Figure 4.20 Standard Parameters

Enter the data for a new standardization and start standardization. The 1SO standard does
not support different parameters for standardizations. Therefore all parameters are set to the
default values when this window pops up, but you may enter any other value.

If you are in WOCE mode the fields will contain the data from the last standardization or the
default values if this is the first standardization.

Volume

Normality

Temperature

Cub. Exp. Coeff.

Start

Cancel

The volume of your iodate standard at the reference temperature of 20
°C. Default volumes are 10 ml for the WOCE standard and 20 ml for the
ISO standard.

The normality of your iodate standard (= 6 molarity) at the reference
temperature of 20 °C. The default values are 0.01 N for the WOCE
standard and 10 mmol/l for the ISO standard.

The current temperature of your chemicals. Note that all reagents and
the thiosulphate titer should have the same temperature. The default
temperature is 20 °C for WOCE and ISO standard.

The cubical coefficient of thermal expansion for the glass of your iodate
pipette. The default value is zero for WOCE and ISO standard.

Starts the new standardization. After standardization you will return to
the Standard Window which will display the new results, if the
standardization was successful.

Leaves the Standardization Window and returns you to the Standard
Window.
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4.3.19.1 First Standard Determination

ile ottle itration Blank alue| st GV raph ptions elp 12:22:23
L 1 Standardization
L 1 Standard Parameters —

Standard Determination

[XK1 1. titration D B.7536 ml
Average : B.?536 ml
Accuracy : B.868688

“ ext 1 raph 1 oy _m ancel 1

Exit standard determination and save value
Figure 4.20.1 First Standard Determination

This window will pop up after the first standard blank titration.

OK

Next
Graph

Log

Cancel

1

Average:

Accuracy:

Leaves the standard determination and saves the new standard value if the
result of the first titration is not disabled.

Start another standard titration.
Displays the curve of the first titration.

Opens the Log menu to write the titration data (titer-transmission pairs) to an
ASCI! file or to print them on a line printer.

Leaves the standard determination without saving the standard value.

Enable or disable the result of the first titration.

The resulting average from all marked titrations (the titer volume after the first
titration if enabled, otherwise zero).

The percentage standard deviation of all marked titrations (zero if less than two
titrations).
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4.3.19.2 Additional Standard Determination

ile ottle itration Blank alue| si5iiGidil] raph ptions elp 12:27:85
L 1 Standardization
L 1 Standard Parameters
Standard Determination
[XK1 1. titration B.7536 ml
[K1 2. titration B.7558 ml
[XK1 3. titration 8.7535 ml
[XK1 4. titration B.7544 ml
[XK1 5. titration 8.7548 ml
fAverage B.7541 ml
Accuracy 8.8551 =
“ ext 1 raph 1 og g ancel 1

Exit standard determination and save value

Figure 4.20.2 Additional Standard Determination

This is the window after some additional standard titrations. Note that the average is now
calculated from all marked titrations. After each standard titration, the window contains one
line more to display the results of all titrations. The maximum number of standard titrations is
limited to ten. Therefore, the 'Next' button is not available after the tenth titration.

OK Leaves the standard determination and saves the new standard value if it is not
zero (all titrations disabled).

Next Starts another standard titration. This button does not exist after the last (tenth)
titration.

Graph Displays the curve of the last titration.

Log Opens the Log menu to write the titration data (titer-transmission pairs) of the
last titration to an ASCI| file or to print them on a line printer.

Cancel Leaves the standard determination without saving the standard value.

1.9,0 Enable or disable the result of the corresponding (first to tenth) titration.

Average: The resulting average from all marked titrations.

Accuracy:  The percentage standard deviation of all marked titrations (zero if less than two

titrations).
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4.3.20 Graph Menu

ile ottle itration Blank alue tandard[f3T0 W ptions elp 12:27:24

Titration Graph

og File Graph

Graph of last titration

Figure 4.21 Graph menu

Titration Graph Displays the graph of the last titration. This command is not available if
the last titration was not successful or no titration was done since the

program start.

Log File Graph Displays the graph of a titration that was saved with the Log command.
After activation, the File Select window is opened to select the log file.
After selection of the file another window is opened to select the data set
from the log file.
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4.3.21 Select Data Set from Log File

ile ottle itration Blank alue tandardlJTT00 ptions elp 12:28:83
I 1
-L 1 Select Data Set

E:~D0A311~8818TEST.LO0OG
ata 3et

Standard titration .85,

Standard titration logged 31.85.1995 14:14
Standard titration logged 86.86.1995 14:086
Standard titration logged 86.86.1995 14:15
Standard titration logged 86.86.1995 14:22
Standard titration logged B6.86.1995 14:32
Standard titration logged 86.86.1995 14:49
. Standard titration logged B6.86.1995 16:88
Titration logged B6.86.1995 16:13

Titration logged B6.86.1995 16:19

Duplicate logged B6.86.1995 16:26

Pk b 0 N s P

raph ancel
IIIJLIIII ----I

Select data set
Figure 4.22 Select Log File Data Set
Select the data set for display of the titration curve.

Graph Displays the titration curve of the currently selected data set. After leaving the
graphics display you are returned to this window for another selection.

Cancel Leaves the selection window.

Note that the displayed date and time stamp is not the time of titration, but the time of data
logging.
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4.3.22 Titration Curve

Titration Graph

£ 25000
=]
M 24900
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=
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22800---smmees [ i AL [ yrTTTT ' ! W Canceled data fduring optimization?
22700 ) I I I I i ] ] ]
50 508 510 512 514 5la 518 520 522 524 524

Titer [ull

ESC-Cancel <G:rid <LrinsLog <Drata field <Prrint  Zoom<dl:n  Zoomddxut < —*
Figure 4.23 Titration Curve
Displays the graph of a titration.

<Esc> Leaves graphic mode.

<G>rid Graphics display with or without grid.

<L>in/Log  Graphics display with linear or logarithm transmission values.

<D>ata field Displays/removes data field.

<P>rint Prints graph to line printer (your printer must be EPSON-FX compatible for
printing in graphic mode).

Zoom <|>n  Enlarges view port.

Zoom <O>ut Reduces view port.

Left Moves graph view port to left.

Right Moves graph view port to right.

At the bottom right of the graph some important values relating to the curve are displayed.
These include the current date and time, the calculated endpoint and the accuracy of the
endpoint calculation. The graph itself will mark the beginning of the slow titration, the inflection
point of the approximation function and the calculated endpoint. If an approximation was
possible this function will be drawn from the slow point to the end line and the corresponding
e-function will be drawn from the inflection point to the endpoint.
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4.3.23 Options Menu

ile ottle

itration Blank alue tandard raphll0T3TTEN elp 12:28:15

Configuration

arameters
xternal

ransmission Test
ardware Test

osimat Functions

eadme File
og File

Conf iguration (ports, bhurette, duplicate control, print control, method)

Figure 4.24 Options Menu

From this menu you can configure your system and make some hardware checks.

Configuration

Parameters

External

Transmission Test

Hardware Test

Dosimat Functions

Readme File

The Configuration window contains settings like photometer port, printer
port, burette volume, Dosimat fill speed, calculation method, monitor
type, duplicate control, and split printing.

The Parameters window allows you to change the titration parameters
like delay times and titer amounts.

Lets you configure up to ten external programs that can be called from
the Options menu.

Continuously displays the photometer values as percentage of
transmission.

Checks the connection between your computer and the hardware
(Dosimat and photometer) and displays the hardware version (1- or
2-channel system), and the remaining memory amount.

The Dosimat Functions menu lets you use the Dosimat for dispensing
specific titer volumes or flush the burette.

An example for an external program call. The example calls the DOS
program EDIT.COM with the file README.DOC.
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4.3.24 Configuration

ile ottle itration Blank alue tandard raphllJT3TIEN elp 12:28:25
I 1
-C 1 Conf iguration

ardware Port rinter Port ill Speed
( J Coml (=) Lpti ( 3 8.5 = Buvol/min
(Z) Com2 () LptZ ( 31.8 = Buolrmin
() Com3 C ) Lpt3 () 2.8 = Buvol/min
( J Comd C ) Lpt4 (=) 3.8 »* Buvol/min
ethod ideo Type urette Volume
(=) WOCE € J Monochrome (=) 1 ml
) IS0 ( ) Color () 5 ml

C J LCD () 18 ml
Printer mulation ) 28 ml
(=) Epson FX-8@ 358 ml
¢ ) HP PCL

[X]1 Duplicate Control [CX]1 Split printing

ave ancel
— ——

Select =erial port for DOA hardware

Figure 4.25 Configuration

Hardware Port

Printer Port

Fill Speed

Method

Video Type

Burette Volume

Lets you select (by mouse or Up and Down key) the serial port for your
DOA hardware. Note that no other hardware should be connected to this
port and no device driver should be installed for this port, because this
could produce unpredictable results.

Lets you select (by mouse or Up and Down key) the parallel port for your
line printer. All printer output (see Printer in the Print Menu and Protocol
in the Titration Window) will be done to this port.

Lets you select from four fixed burette fill speeds. The fill speed is only
valid for burette filling by the program, not for filling by the user. The
maximum fill speed (three burette volumes per minute) results in a filling
time of 23 seconds.

Selects WOCE or ISO standard. For the differences between the
standards see Chapter 2 - Function Description, section 2.3 - Titration
Procedures.

Lets you select your monitor type and video card. You can choose
between Monochrome (Black & White monitor with Hercules card), Color
(Color monitor with color card, e.g. CGA, EGA, VGA) and LCD (Liquid
Crystal Display or grey scale monitor).

Lets you select (by mouse or Up and Down key) the cylinder volume of
your burette. Be sure to have the correct volume (it is printed in front of
the exchange unit), because all titration results are based on the burette
volume.
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Printer Emulation

Duplicate Control

Split Printing

Save

Cancel

The DOA software supports two printer languages. These are Epson
FX-80 for a wide range of pin writers and HP Laser Jet (PCL) for Laser
Jets and compatibles.

When this option is enabled you have the choice to titrate duplicate
samples according to the WOCE specifications. Duplicate samples are
two titrations from identical samples. The absolute difference between
the oxygen concentrations of these titrations should be very small. The
statistics about duplicate samples and the ratio between duplicate and
single samples are stored in the data files. Therefore, we have two types
of data files: Files with and without duplicate samples. So you need
another data file for your titration data if you toggle this option on or off.

Printing all data fields from a data set in one line will exceed the line
width of standard printers. If you do not have a wide carriage printer, you
can select Split Printing to print partial data sets on two pages.

Saves the settings in the configuration file, leaves the Configuration
Window and returns you to the Options Menu.

Leaves the Configuration Window without saving the settings and
returns you to the Options Menu.

4.3.25 Titration Parameters

ile ottle

itration Blank alue tandard raphllIT3TETEN elp 12:28:35
onf iguration

xternal

ransmission Test
ardware Test

Titration Parameters

Step size : 'l BuvolslBBEE = B8.5 pl
Wait time : 18 =
Fast delay 2 =
Slow delay : 2 =
Fast factor : B.96

ave I

ancel I

Step size during slow titration [1 — 188 = Buvol- 108681

Figure 4.26 Parameters

Step size

The step size defines the amount of titer that is dispensed on every step in the

slow titration phase. The smallest possible amount is 1/10000 of the burette
volume. The default value is 5; allowed inputs are in the range from 1 to 100.
Greater volumes result in less accurate titration and smaller volumes increase
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Wait time

Fast delay

Slow delay

Fast factor

the titration time. The absolute amount of titer in pl is calculated according to the
current burette volume and is displayed behind the entry field.

After the fast titration phase, the system has to wait some time to ensure that
the total amount of dispensed titer has reacted. The default value is 10
seconds; allowed inputs are in the range from 1 to 60 seconds. This parameter
has no effect in the demonstration version.

This parameter specifies the delay time after each step in the fast titration
phase. The default value is 2 seconds; allowed inputs are in the range from 1 to
60 seconds. If the delay time is too short, it could occur that the sample is over
titrated. Greater times result in longer titration times. This parameter has no
effect in the demonstration version.

This parameter specifies the delay time after each step in the slow titration
phase. The default value is 2 seconds; allowed inputs are in the range from 1 to
60 seconds. The time has to be long enough to ensure that the titer amounts
can react. Note that the reaction time depends also on the step size (see
above) and the mixing parameters (stirrer speed, type of bottle and stirring bar).
This parameter has no effect in the demonstration version.

This parameter exists only when a 2-channel system is used. The factor defines
up to what transmission, relative to the estimated endpoint, the fast titration
phase will run. The default value is 0.92; allowed inputs are in the range from
0.01 to 1.0. The greater the factor is, the faster the titration will run but with the
risk of over titration.

4.3.26 External Program Configuration

ile ottle itration Blank alue tandard raphllJT3TTEN elp 12:28:42
-C 1 External programs
elect
Menu String Program name Scr Int Hait
1 Readme File BLIST L 1C1CLC 1
Z Log File eLIST L1C1C1
3
4
5
6
?
8
9
18
ditor: EDIT.COM @FILE
ister: EDIT.COM @FILE
K ancel
— —

Select external command to edit

Figure 4.27 External Program Configuration
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From within this menu you can configure up to ten external DOS programs that can be started
from the Options menu.

Select Choose an existing entry for editing or removing or an empty line to create a
new one.

Editor Specifies the file name and path of the external editor. The entry may contain
additional command line parameters. Please insert the macro '@FILE' at the
position for the working file name. Note that the Text File item from the File
menu is not available if this field contains no entry to an existing editor. The
default entry uses the MS-DOS editor and requires that the files EDIT.COM and
QBASIC.EXE are stored in a directory that is part of the DOS PATH setting.
Lister Specifies the file name and path of the external lister. The input format is
identical to the Editor field.

4.3.26.1 Edit External Program

ile

ottle itration Blank alue tandard raphlllTFGTTEN elp 12:28:49
L1 External programs
elect L JExtermal program configuration
Menu String
1 Readme File enu string
Z Log File “Readme File
3
4 rogram/Command line
5 GLIST READHME.DOC
b
7 tatus line
(E] Show readme file
9
14 L 1 RestorerSave DO3 screen
L 1 Internal DO3 command
ditor: EDIT. L 1 Wait after executing
ister: EDIT. K B ancel B

Enter the string that should appear in the menu ('™’ in front of hotkey)

Figure 4.28 Edit External Program

Menu String The string that is displayed in the Options menu. To remove this

command from the list, clear this input field. Place a V" in front of the
hotkey.

Command Line The command line that is passed to DOS when activating the

corresponding Options menu entry. You may use these macros:

@LIST The external lister

@EDIT The external editor

@D The current data file name

@L The current log file name

@T The current text file from the Print menu
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Status Line The status message that is displayed when the cursor is on the
corresponding line in the Options menu.

Restore/Save When enabled, the old DOS screen is restored before executing the
external program and saved after return. Otherwise the external program
is started in a blank screen.

Internal Command If the command is not an executable (BAT, COM or EXE) but an internal
DOS command (e.g. DIR, TYPE) you must enable this option.

Wait Key If this option is enabled, the program waits for a keystroke after

executing the external command. This option is useful to have a look at
the external program output before returning to DOA.

4.3.27 Transmission Test

ile ottle itration Blank alue tandard raphllJTFETEN elp 12:28:57
onf iguration
arameters
xternal
L 1= Transmission Test duware Test

Transmission bhlue: 188.4 = t Functions

Transmission red: 1684.2 =

Factor (red-bhluel: 1.84 File

Transmission test
Figure 4.29 Transmission Test
In this window the photometer values of the blue and red (for 2-channel systems) beams will

be displayed continuously. The output is in percentage transmission relative to an absolute
transmission value of 30,000. Note that greater values than 100% are possible and valid.
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4.3.28 Hardware Test

ile ottle itration Blank alue tandard raphllITINTEN elp 12:29:84
onf iguration
arameters
xternal

| Hardware Test — Info
Dosimat : Detected
Photometer : Detected
Hardware version : 2 channels
Status bhlue bheam : Ok
Status red beam : Ok
fivailahle memory : 91368 Bytes

Hardware test
Figure 4.30 Hardware Test

Checks the hardware (Photometer, Dosimat), the hardware version, and displays the
amount of free memory.

The status displayed for each test means:

Detected: No errors (Photometer and Dosimat)
Not Detected: Hardware not found (Photometer, Hardware Version and Dosimat)
1-/2-channels: The hardware version. If you are working with a 2-channel system and

the program detects only a one channel system, check the cable
between computer and titrator.

OK (nnn %): The transmission is in the correct range.

Too high (nnn %): Transmission is too high, calibration necessary

Too low (nnn %):  Transmission is too low, calibration necessary

If the transmission is too low or too high, a message will be displayed that a new
calibration is necessary. If the transmission is too high you can still use the titrator
providing the transmission for a bottle with pure water is below 93.4 % and the
transmission without bottle is below 109 %. If the transmission is too low (less than 93.4%
without bottle) the system will not work.

Note that the photometer has a warmup time of about five minutes and that the
transmission values in the warmup phase could be out of range.

48



4.3.29 Dosimat Functions

ile ottle itrationm

Blank alue tandard raphllJT3TTEN elp 12:29:10

onf iguration
arameters
xternal

ransmission Test
ardware Test

-L 1

Dosimat
Dizspensing olume: 1.8 ml
Total Dispensed: A.80880 ml
Remaining in bhurette: 1.686008 ml

ill 1 elp 1 anl::ell

L 1 Continuous dispensing

Start dispensing

Figure 4.31 Dosimat Functions

Dispensing Volume
Continuous dispensing

Start
Stop

Fill
Help
Cancel

Total dispensed:
Remaining in burette:

Entry field for the volume that will be dispensed when activating
the Start button.

Continuously dispense and fill burette. This option is useful if you
want to flush your burette.

Start dispensing.

Stop current dispensing. After activating the Start button it will
change to a Stop button.

Fill the burette and reset the total volume.

Opens the help screen for the Dosimat functions.

Leave the Dosimat window.

Total amount of dispensed titer since last Fill activation.
Current amount of titer in the burette.
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4.3.30 Help Menu

ile ottle itration Blank alue tandard raph ptions[[[ZF0 12:29:17
| Help on Help |
ndex

Help about help system
Figure 4.32 Help Menu

Get Help on some specific items.

Help on Help Displays the help text about the usage of the help system.
Help Index Displays the Help Index list.
ile ottle itration Blank alue tandard raph ptions[[[EF0 12:29:29
elp on Help

L 1 Help 1
ABSOLUTE AMOUNT OF 0Z FROM REAGENTS T
BLANK DETERMINATION '

BLANK UALUE

BOTTLE EXPANSION COEFFICIENT
BOTTLE MANAGEMENT

BOTTLE HUMBER

BOTTLE VOLUME

BURETTE FILL SPEED

BURETTE VOLUME

CONFIGURATION

DEVIATION DATA
ndex ancel
---. ----I

Scroll: Select:

Figure 4.33 Help Index
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To select an item use the <Up>, <Down>, <PgUp> or <PgDn> key and press return or use
the scroll bar with the mouse and double click on the left button at the desired item.
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Chapter 5
Printings

5.1 Printers

To produce readable printer output your printer must be able to print the IBM PC character
set. For printing complete data files, titration protocols or titration curves, your printer must be
EPSON-FX or HP PCL compatible.

If you don't have a compatible printer, you may use a screen capture program to send the
graphics screen image to your printer. Some capture programs make it possible to merge
screen images into documents produced by some word processors. These programs are
useful with any program including DOA, from which you want to capture a graphics screen
image.

Most screen capture programs are resident programs that must be run before you start DOA.
They are usually activated by pressing the <PrintScreen> key.

5.2 Printing Formats

This section will give you an overview of the printing formats produced on line printer or text

file output. The frames are not part of the printings.

Figure 5.1 Bottle List

No. Vol une a
63 59.710 m 1.0E-5 1/°C
64 59.540 m 1.0E-5 1/°C
65 59.500 m 1.0E-5 1/°C
77 59.560 m 1.0E-5 1/°C
79 58.990 m 1.0E-5 1/°C
80 59.920 m 1.0E-5 1/°C
93 59.090 m 1.0E-5 1/°C
98 59.790 m 1.0E-5 1/°C
99 59.710 m 1.0E-5 1/°C

Figure 5.2 Standard data (WOCE mode)

Last standardi zati on : 03.12.1992 11:42
Vol une (20°C) : 10. 0000 ni
Normality (20°C) : 0. 0100

Vol une (Tstd) ; 10. 0000 mni
Normal ity (Tstd) : 0. 0100
Tenperature Tstd : 20.000 °C
Cubi cal expansion coeff. : 1.0E-5 1/°C
Titer vol unme : 0.8844 n
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Figure 5.3 Blank Data

Last bl ank determ nation : 01.12.1992 11:21
Bl ank val ue : -0.0002 n

Figure 5.4 Single Data Set (WOCE mode)

Met hod . WOCE

Dat e : 01.02.93

Ti me . 13: 27

Station . SIS

Dept h . 0 m
Bottl e numnber : 64

Bottl e vol une (Tp) : 59.531 ni
Bottl e volunme (20°C : 59.540 ni
Cubi cal expansion coeff. : 1.0E-5 1/°C
Sanpl e tenperature Tsw : 3.200 °C
Pi ckling tenmperature Tp : 4.100 °C
Titer tenperature Ttit : 19.100 °C
Salinity : 31.400 psu
Burette vol une : 1 m

Bl ank vol une : -0.0016 m

St andard vol une : 0.7223

| odat e vol une : 10. 0000 m

| odate normality : 0. 0100
Reagent vol une : 2.0000 m
Abs. oxygen fromreagents : 0.0017 m
Accuracy of endpoi nt : 0.029 %
Titer vol unme 0.3794 nmi

Q2 concentration 5.0918 m /|
Q2 concentration 7.2765 ny/ |
Q2 concentration 221.853 mM kg
Q2 concentration 67.091 %
Comrent Deno neasur enent
Figure 5.5 Deviation Data

Replication and precision

File : C \ DOA\ DEMD WOCE_D. DAT
Nunber of replicates : 3

Nunber of single sanmples : 32
Replication ratio : 8 %
Max 2 concentration : 8.980 m /|
St andard deviation s : 0. 017
Reproduci bility : 0.37 %
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Figure 5.6 Log File

Titration | ogged 22.05.1995 09: 05

Dat e 22.05.95
Ti me : 09:04
Station . station
Dept h : 0
Bottl e nunber : 99

1 0.0 5007 1

2 54.7 6602 1

3 103.3 8453 1

4 144.8 10451 1

5 178.6 12423 1

6 204.8 14197 1

7 224.2 15694 1

8 237.9 16853 1

9 247.1 17684 1

10 253.1 18266 1

11 256.9 18637 1

12 259.3 18895 1

13 260.7 19059 1

14 261.4 19181 1

15 261.9 19258 0

16 262.4 19338 0

17 262.9 19405 0

18 263.4 19483 0

19 263.9 19558 0

20 264.4 19645 0

21 264.9 19721 0

22 265.4 19795 0

23 265.9 19880 0

24 266.4 19957 0O

25 266.9 20036 0

26 267.4 20107 2

27 267.9 20199 0

28 268.4 20272 0

29 268.9 20355 0

30 269.4 20448 0

31 269.9 20521 0

32 270.4 20597 2

33 270.9 20690 0

34 271.4 20776 0O

35 271.9 20857 0

36 272.4 20940 O

37 272.9 20947 0

38 273.4 20945 0

39 273.9 20948 0

40 274.4 20932 0

41 274.9 20943 0

42 275.4 20937 0

43 275.9 20937 0

44 276.4 20944 0

45 276.9 20937 0
Slow titration index: 14
Inflection point index: 35
Optim ze end point index: 35
End transmi ssion: 20941
Used end point: 272.39 ul
No poly end point: 272. 35 pl
Inflection point titer: 271.90 yl
Inflection point |In(transm ssion): 9. 9455
Sl ope at inflection point: 0. 00809627
Accur acy of endpoint detection: 0.011
Pol ynom al coefficient A 1. 46378098E+001
Pol ynom al coefficient B: -6.57695760E- 002
Pol ynom al coefficient C 2. 63590955E- 004
Pol ynom al coefficient D - 3.13248045E- 007
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Figure 5.7 Complete Data File Part 1

File: C:\DOA\WOCE D.DAT

Date Time Station Depth Bo# BotVol BVol20 Botx Tsw Tpick
01.02.93 13:24 SiS 0 63 59.71 59.71 1.0E-5 14.30 14.70
01.02.93 13:27 Sis 0 64 59.53 59.54 1.0E-5 3.20 4.10
01.02.93 13:31 Sis 0 65 59.49 59.50 1.0E-5 -0.40 1.20
01.02.93 13:34 Sis 0 77 59.56 59.56 1.0E-5 17.30 17.45
01.02.93 13:37 SiS 0 79 58.99 58.99 1.0E-5 23.40 23.35
01.02.93 13:41 Sis 0 80 59.92 59.92 1.0E-5 17.30 17.30
01.02.93 13:44 Sis 0 93 59.08 59.09 1.0E-5 6.70 7.10
01.02.93 13:47 Sis 0 98 59.79 59.79 1.0E-5 18.30 18.30
01.02.93 13:50 SiSs 0 99 59.71 59.71 1.0E-5 12.10 12.40
01.02.93 13:53 Sis 0 63 59.70 59.71 1.0E-5 4.50 4.90
01.02.93 13:55 Sis 0 64 59.54 59.54 1.0E-5 17.20 17.25
01.02.93 13:59 Sis 0* 65 59.50 59.50 1.0E-5 15.60 16.10
01.02.93 13:59 SiS 0* 77 59.56 59.56 1.0E-5 15.60 16.10
01.02.93 14:06 Sis 0 79 58.99 58.99 1.0E-5 13.20 13.40
01.02.93 14:10 Sis 0 80 59.92 59.92 1.0E-5 23.90 23.80
01.02.93 14:14 Sis 0 93 59.08 59.09 1.0E-5 2.20 2.80
01.02.93 14:17 Sis 0 98 59.79 59.79 1.0E-5 16.80 17.00
01.02.93 14:20 Sis 0 99 59.71 59.71 1.0E-5 18.10 18.10
01.02.93 14:24 Sis 0 63 59.71 59.71 1.0E-5 18.20 18.10
01.02.93 14:27 Sis 0 64 59.53 59.54 1.0E-5 3.20 4.10
01.02.93 14:31 SiSs 0 65 59.49 59.50 1.0E-5 8.70 9.30
01.02.93 14:35 SisS 0 77 59.56 59.56 1.0E-5 14.30 14.70
01.02.93 14:40 Sis 0* 98 59.79 59.79 1.0E-5 15.40 15.80
01.02.93 14:40 Sis 0* 99 59.71 59.71 1.0E-5 15.40 15.80
05.02.93 12:38 SiS 0 63 59.71 59.71 1.0E-5 15.30 15.50
09.02.93 10:59 Sis 0 63 59.71 59.71 1.0E-5 17.60 17.70
09.02.93 11:07 Sis 0 99 59.71 59.71 1.0E-5 17.60 17.70
10.02.93 13:37 Sis 0 63 59.71 59.71 1.0E-5 12.30 12.50
10.02.93 13:42 Sis 0 64 59.54 59.54 1.0E-5 17.10 17.20
10.02.93 14:07 Sis 0 65 59.49 59.50 1.0E-5 8.60 8.90
10.02.93 14:10 Sis 0 77 59.56 59.56 1.0E-5 11.70 11.90
10.02.93 15:52 Sis 0 79 58.99 58.99 1.0E-5 17.10 17.10
10.02.93 15:56 SiS 0 99 59.71 59.71 1.0E-5 17.10 17.10
03.03.93 09:49 Sis 0 63 59.71 59.71 1.0E-5 17.10 17.10
03.03.93 09:55 Sis 0 64 59.54 59.54 1.0E-5 17.10 17.10
03.03.93 10:58 Sis 0 65 59.49 59.50 1.0E-5 10.20 10.70
19.04.93 11:07 Sis 0* 64 59.53 59.54 1.0E-5 10.20 10.70
19.04.93 11:07 Sis 0* 65 59.49 59.50 1.0E-5 10.20 10.70

Ttit

.10

Sal.

Bur

PR RPRRRPRRPRRPRRRPRRPRERRRRPRRRRRRRRRERRRRRERRRRRRRE R
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Figure 5.8 Complete Data File Part 2

Page: 1
Blank Stdvol IOVol ION RegVol DOReg TitVol Acc. ml/1 mg/l pM/kg % Comment

-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0107 0.3678 4.921 7.03 219.9 68.8 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0292 0.3794 5.092 7.28 221.9 67.1 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0137 0.3138 4.213 6.02 183.2 51.4 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0215 0.5678 7.620 10.89 336.2 126.2 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0143 0.6080 8.242 11.78 364.0 153.9 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0165 0.4517 6.023 8.61 264.5 103.6 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0141 0.4775 6.461 9.23 282.5 90.1 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0136 0.2796 3.733 5.34 163.1 68.5 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0128 0.3611 4.831 6.90 210.3 79.5 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0081 0.4103 5.491 7.85 239.8 73.4 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0131 0.4462 5.989 8.56 262.2 105.4 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0248 0.4477 6.013 8.59 263.3 102.2 Demo duplicate
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0265 0.4478 6.008 8.59 263.1 102.1 Demo duplicate
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0149 0.2785 3.771 5.39 164.2 63.5 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0294 0.2792 3.720 5.32 162.7 75.8 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0175 0.3881 5.250 7.50 229.0 66.7 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0137 0.4247 5.675 8.11 248.4 99.2 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0125 0.4298 5.751 8.22 253.0 99.3 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0148 0.2122 2.836 4.05 123.9 51.9 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0191 0.4326 5.807 8.30 255.5 70.4 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0166 0.3780 5.076 7.25 221.9 74.6 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0146 0.3023 4.054 5.79 177.2 67.8 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0131 0.3694 4.935 7.05 216.6 81.9 Demo duplicate
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0105 0.3702 4.953 7.08 217.4 82.2 Demo duplicate
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0108 0.6707 8.980 12.83 396.5 141.6 Demo measurement
-0.0016 0.7223 10.000 0.0100 2.0000 0.0017 0.0110 0.3536 4.730 6.76 207.1 84.1 Demo measurement
-0.0016 0.7117 10.000 0.0100 2.0000 0.0017 0.0270 0.4294 5.832 8.33 256.3 100.5 Demo measurement
-0.0026 0.7117 10.000 0.0100 2.0000 0.0017 0.0223 0.3137 4.266 6.10 186.2 69.2 Demo measurment
-0.0026 0.7117 10.000 0.0100 2.0000 0.0017 0.0151 0.4239 5.780 8.26 253.2 100.9 Demo measurement
-0.0026 0.7117 10.000 0.0100 2.0000 0.0017 0.0135 0.5037 6.872 9.82 302.6 94.8 Demo measurement
-0.0026 0.7117 10.000 0.0100 2.0000 0.0017 0.0116 0.4822 6.572 9.39 289.9 96.2 Demo measurement
-0.0002 0.7806 10.000 0.0100 2.0000 0.0017 0.0164 0.4349 5.444 7.78 238.3 95.8 Demo measurement
-0.0002 0.7806 10.000 0.0100 2.0000 0.0017 0.0090 0.4587 5.672 8.11 248.3 99.6 Demo measurement
-0.0002 0.7410 10.000 0.0100 3.0000 0.0017 0.0140 0.5173 6.862 9.81 302.1 115.3 Demo measurement
-0.0002 0.7410 10.000 0.0100 3.0000 0.0017 0.0147 0.5075 6.752 9.65 297.1 113.8 Demo measurement
-0.0002 0.7410 10.000 0.0100 3.0000 0.0017 0.0216 0.6736 8.978 12.83 396.0 126.9 Demo measurement
-0.0002 0.8409 10.000 0.0100 3.0000 0.0017 0.0114 0.5608 6.574 9.40 286.7 102.1 Demo duplicate
-0.0002 0.8409 10.000 0.0100 3.0000 0.0017 0.0212 0.5609 6.580 9.40 287.0 102.1 Demo duplicate
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Chapter 6
Messages

6.1 Warning Messages

WO0010:

WO0011:

W0020:

W0021:

WO0030:

WO0040:

WO0050:

WO0060:

WO0071

WO0072:

WO0073:

Hardware not detected
This warning message will be displayed after starting the program if the
photometer and/or the Dosimat are not ready. Remember that the photometer
has a warmup time of about five minutes. Ignore the warning if you don't want
to make a titration (e.g. if you only want to view data from previous titrations).

Dosimat not powered or not connected
The Dosimat is not powered (red mains switch at the rear side) or there is no
connection between the interface box and the Dosimat (mains cable or data
link cable). Ignore this warning if you only want to view or print data from
previous titrations.

Configuration file not found
The configuration file could not be found. The program will use the default data.
Note that you cannot start a titration, because the standard data will be set to
zero.

No bottle file
The program could not find the bottle file. Before starting any titration you have
to create the bottle file.

Too many directory entries
The selected directory contains more entries than the internal buffer can hold.
The file list will not display all entries. Ignore this warning if the files you want
are in the list or use a search mask to display a subset.

Bottle number has not changed. Start titration?
You did not enter a new bottle number before starting the new titration. Choose
'Yes' to start the titration or 'No' to go back to the Titration Parameter window.

Duplicate sample ratio below 10%
If duplicate control is enabled, this warning message will be displayed each time
you are starting a normal titration (no duplicate) if the ratio of duplicates to all
data sets in the current data file is below 10%.

Burette was filled during titration
The burette has to be refilled during titration (the dispensed titer volume was
greater than the burette volume). Therefore, the titration result may be
inaccurate.

: Approximation failed

The endpoint calculation algorithm fails. Therefore, the results may be inexact.
To decide if the detected endpoint is correct use the Graph command to display
the titration curve for examination. This warning is produced when the endpoint
calculation by polynomial approximation is not possible. But the endpoint is still
calculated by a simpler method (linear regression).

Titration is too fast
At the end of the fast titration phase there is too many titer that has not reacted.
To avoid this warning increase the stirrer speed, use bigger stirrer bars and / or
increase the fast delay time.

Not enough steps inside slow titration phase
There are not enough titration steps during the slow titration phase. Therefore,
an approximization of the titration curve is not possible and the result may be
inexact. To avoid this warning, decrease the fast factor for 2-channel systems
or decrease the primary shot or percentage endpoint for 1-channel systems.
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WO0074: Zero concentration detected
The system detected a zero concentration for the sample. If there is really a
zero concentration choose OK. Choose Cancel if the zero concentration is
sourced by an error (e.g. burette tip not inside sample bottle).

WO0080: Too many data sets in log file
The selected log file for titration curve display contains more data sets than the
internal buffer can hold. Therefore, the list box contains only the oldest data
sets from the file. To select all data sets, the log file must be splitted into two or
more files (e.g. with an ASCII editor).

WO0090: File not saved; Save ?
The contents of the file has changed since the last saving or loading. Choose
'Yes' to save the file contents.

WO0100: Bottle exists already; overwrite ?
There is already a bottle with the specified number in your bottle file. You can
overwrite the old data or cancel the input.

WO0110: File exists already
A file with that name exists already. You can choose from overwriting,
appending data, or cancelling the operation.

6.2 Error Messages

E1010: Not enough memory
There is not enough memory to execute the selected option. To get more free
memory leave the program and remove resident programs.

E1020: Graphics error
The program could not identify your graphic system. Therefore, the Graph
command is not available. If you have a Hercules graphic card, this error will
occur if the terminate-and-stay-resident program MSHERC.COM is not
installed.

E1040: Internal error
Internal (menu system) error. Please contact SiS to report this error. (See note
below).

E1050: User break
A running titration was interrupted by pressing the <ESC> key. Choose 'OK' to
stop the titration or 'Cancel' to resume. Note that resuming could produce less
accurate results if the titration was interrupted during the slow titration phase.

E1060: Input out of range
The entered value is out of range. The range for valid input is generally
displayed at the status line.

E1070: Cannot execute command processor or child process
The command processor (COMMAND.COM) was not found or the argument
list exceeds 128 bytes. The program tries to locate the command processor by
the environment variable COMSPEC. If this fails, the shell command is not
available. For further information see your DOS manual.

E2010: No bottle data available
The bottle file could not be found or it is empty. Before starting any titration you
have to enter a valid bottle number. Therefore, you must create a bottle file first.

E2020: No data available
This error occurs when you select the Graph command and no titration was
done since program start or the last titration was not successful.

E2030: Missing standardization data
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E2040:

E2050:

E2060:

E3010:

E3020:

E3030:

E3050:

E3060:

E4000:

E4010:

ES5000:

E5001:

E5002:

E5003:

Before starting any smaple titration you have to standardize your titer.

Unknown bottle number
There is no bottle with the specified number in your bottle file. Check if you
entered the correct number or tell the program the new bottle by using the Add
Bottle command in the Bottles Menu.

Transmission not decreased with bottle
Before starting a titration the system has to know the red and blue transmission
values without and with a bottle. If the blue transmission with bottle is not below
the transmission without bottle minus 5 percent, this error occurs. So choose
OK to restart the calibration procedure or Cancel the titration.

It seems that there is no bottle in the photometer
Before starting an additional titration for blank or standard determination the
system checks the blue transmission value. If this value is greater than the
transmission without bottle from the first titration minus 5 percent, there is
probably no bottle in the photometer.

Photometer/Dosimat not detected
Before any titration the program will check if the photometer and the Dosimat
are connected to the computer and powered. If the check fails, you will get this
error message.

Time out reading photometer
The connection to the photometer is interrupted. If this error occurs inside a
titration, cancel the process and check the hardware.

Time out sending to Dosimat
The connection to the Dosimat is interrupted. If this error occurs inside a
titration, cancel the process and check the hardware.

Invalid port number
Your computer has no interface with the specified number. Use the
configuration menu to select a valid port.

Mouse active at selected hardware port
There is an active mouse driver at the serial port. Change the hardware port or
leave the program and disable the mouse driver.

Too many titration steps
The titration was interrupted, because the number of titration steps is greater
than the internal buffer can hold (1000). This error can occur when you enter a
very low estimated endpoint (or percentage transmission start value for 1-
channel systems) or your titer concentration is very small. In these cases a
greater buffer would not be an advantage, because the titration results would be
too inexact.

Titration failed
The titration was not successful. The frequent source for this error is an over
titration. To avoid over titrations enter a lower estimated endpoint (or primary
shot for 1-channel systems) or use a smaller titer concentration.

Can't open file or device
Reading: The device is an output device.
Writing: The file or disk is write protected or the device is an input device.

Seek error
Seek error during disk access. Leave the program (e.g. by the OS-shell
command) and check your disk and drive.

Read error
Read error during disk access. Leave the program (e.g. by the OS-shell
command) and check your disk and drive.

Write error
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E5010:

E5011:

ES012:

E5020:

E5030:

E5040:

E5050:

E5051:

E5060:

E5061:

E5062:

E5063:

E5064:

E5070:

ES5080:

Write error during disk access. Leave the program (e.g. by the OS-shell
command) and check your disk and drive.
Device not ready
Drive or device not ready (e.g. no disk in drive, printer off line).
Printer not ready
Your printer is not powered, not on line, busy, or not connected to the selected
port.
DOS device error
Critical DOS device error. Clear the error source and choose RETRY.
Disk full
Your disk is full. Change the disk or delete files and restart output operation.
File/path not found
A file and/or path with that name does not exist.
No matching file/directory found
There are no directories and no files that match the search mask on your disk.
Invalid drive/path
A drive and/or path with that name does not exist.
Invalid file name
The file name does not match the MS-DOS specifications for file names (max. 8
characters for name, 3 characters for extension).
Invalid configuration file
The file is not a valid DOA configuration file.
Invalid data file
The file is not a valid DOA data file.
Invalid bottle file
The file is not a valid DOA bottle file.
Invalid data file type
The data file does not match the current settings. There are four types of data
files: with or without duplicates and WOCE or ISO mode. Select a matching file
or enter a new file name.
Invalid log file
The selected log file for titration curve display is not a DOA log file or it was
modified.
File is read only
The read only attribute of the file is set. To get write access, you must reset the
R/O attribute (e.g. with the DOS command ATTRIB).
File is not executable
The file is not a COM, EXE or BAT file or it has an invalid executable-file format.

E60xx: DOS device error

E700x:

E800x:

Critical DOS device error. The only way to go on is to clear the error source and
to choose 'Retry'. If you choose 'Abort' the program will terminate without saving
any data! (Sorry, that's MS-DOS).

Math error
Mathematical function error. Please contact SiS to report this error. (See note
below).

FP87 error
Floating point error. Please contact SiS to report this error. (See note below).

EXXXX: Internal error in error function

During error handling an internal (menu system) error occurs. XXXX is the
number of the original error. (See note below).
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Note to all errors that appear during titration (E40xx):

If a titration fails, the titration data will be written to the ASCII file DOA.ERR in the current
directory. If the file exists already, the data will be appended. Therefore the file should be
renamed or deleted after some time. The error file may be useful if too many titration failures
occur to detect the error sources.

Note to errors E1040, E700x, E800x and Internal error in error function:
We have tried to make this program error free, but nobody is perfect. To prevent system
'hangups', resulting in lost data, we have included many error checks for critical errors to save

all data before leaving the program. If one of these errors occurs, please report the error and
the circumstances (current program step, menu level) to us.
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Chapter 7
Customer Service

Warranty:

SiS warrants this instrument to the original purchaser to be free of defects in material
or manufacturing for a period of one year. Liability is limited to repair or replacement of
the defective part which will be done without charge if the instrument is returned to our
factory prepaid. This warranty does not apply to any glass or plastic parts or to
instruments subjected to misuse or tampering. No responsibility or warranty for
consequential damage is included in the sale of this instrument.

Software updates:

SiS guarantees a free of charge software update for one year.

Please report errors or make suggestions in writing or phone us for questions, that can only
be answered by phone.

SiS Sensoren Instrumente Systeme GmbH
Muhlenkoppel 12

D-24222 Schwentinental

Germany

Tel.: +49 431 799720

Fax: +49 431 79972 11

Email: info@sis-germany.com

WWW: http://www.sis-germany.com
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